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Limited Warranty Agreement 
ALLEN DATAGRAPH LE Series Laser Etching and Cutting System are warranted to be free of 
defects in both materials and workmanship. Should any part of this equipment be defective, it will 
be repaired or replaced, at the option of the manufacturer, at no charge for parts or factory labor 
for a period of one (1) year from the date of installation. All warranty services are performed at 
the Allen Datagraph factory.   Replacement parts not installed at the factory will be billed to the 
customer at regular prices and credit will be issued when the defective parts are returned. The 
customer is responsible for freight on warranty parts and repairs. 

This warranty is void if: 

1. The equipment has been damaged by negligence, accident or mishandling, or has not 
been operated in accordance with the procedures described in the operating instructions;  

or: 

2. The equipment has been altered or repaired by other than an approved service station or 
factory service center, or adaptations or accessories have been attached to the equipment 
that shall have adversely affected the performance, safety, or reliability of the equipment. 

NO OTHER WARRANTY, EXPRESSED OR IMPLIED, APPLIES to the equipment. Allen 
Datagraph does not assume any responsibility for consequential damages occasioned by the 
equipment, or inconvenience or interruption in operation. 

In case of unsatisfactory operation, Allen Datagraph or its Dealer should be notified immediately. 

Technical Support 
Up to 4 hours of calls in technical support is available at no charge during the warranty period.  
Technical support is available during business hours based on Eastern Time Monday thru Friday.   
Technical support outside the limits stated will be billed at current rates.   

For Technical support call: 603-893-1983   

Installation 
Site Preparation 

The engraver should be installed on ground floor of a facility to minimize the effects of vibrations 
from people walking by, showing up in the image.  There should be at least a 2-foot preferable 3-
foot wide area around the machine to allow walking completely around the machine while it is in 
operation without contacting the machine.  Touching the machine while it is running with wreck 
the image.  The conveyer-mounting block in the engraving area should be built up 18-24 inches 
with a poured cement block so that when you are adjusting the leveling jacks you do not need to 
bend over all the way to the floor.  If you are planning on engraving items weighing over 100 lb 
an overhead crane will be required to lift and move the objects being engraved.  The model 4800 
needs an area 15 ft x 11 ft of floor space.  The model 6000 needs an area of 15 ft x 13 ft.  The 
model 9600 needs 15 ft x 15 ft of floor space.  The model 14400 needs an area of 15 x 19 ft of 
floor space.  See appendix A for an example floor space layout. 

Dedicated Computer Requirements 
For best image quality and since the computer is intimately involved with the sending of the 
image no other program should be run on the computer while it is send the image to the engraver.  
This requires a dedicate computer tied to a network to allow preparation of images on another 
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computer.  The minimum requirements for the dedicated computer is Pentium Processor at 500 
Mhz with 256Mb Ram, 1GB free hard drive, serial port, running Windows 98, ME, 2000 or XP. 

List of Parts Delivered 

Engraver Frame with electronic box  Box with control boards and clamps, 2 power cords, 

Arm  Laser  Compressor  

Allen wrenches, T square  Laser alignment tool  Lens   

Focus Spacing Tool  Leveling/Focusing scissor jacks (3)  
Conveyer  

4x4 blocks for build up (4 short and 4 long)  2x4 blocks for build up (10 
pieces), 2 Plates/boards for top and bottom of build up 
Socket for jacks 
Ratchet wrench 

Machine Assembly 
• Install 2 circuit boards from separate box.  Attach board clamps.  Tighten clamp screw 

until boards no longer move. 
• Bolt down frame to floor. 
• Attach arm to frame and tighten Allen screws. 
• Attach umbilical chain to arm with screws.  
• Connect x motor power (2 wire) from arm to motor connection 
• Connect power for x motor encoder transmitter. (3 wire) 
• Connect optical cable xa to x motor encoder transmitter board xyoa 
• Connect optical cable xb to x motor encoder transmitter board xyob 
• Connect y motor power (2 wire) from arm to motor connection 
• Connect power for y motor encoder transmitter. (3 wire) 
• Connect optical cable ya to y motor encoder transmitter board xyoa 
• Connect optical cable yb to y motor encoder transmitter board xyob 
• Connect gas tube 
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• Do not attach laser yet. 
Connect Power Cord 

Some Allen Datagraph products require specialized installation in order for the limited warranty 
to remain in effect, ask your dealer or contact technical support at Allen Datagraph for details. 

Unpack all accessories from the unit. 

Power Connection 
Important Note: Use of a HIGH QUALITY surge protector or uninterruptible power supply (600 
watts) is REQUIRED by Allen Datagraph Systems. Failure to do so could affect your warranty 
coverage if a problem arises due to improper power connection. 

CAUTION: The power cords are a three-conductor cable that incorporates a safety (earth) 
ground connection. For the machine to operate safely and correctly, the power cord must be 
plugged into an outlet that has an earth ground contact. Never plug the power cord into a two-
prong outlet by using a 3=2 cord adapter.  

Allen Products can be configured to operate from any of the following power sources: 

115 VAC / 48-66 Hz or 230 VAC / 48-66 Hz 

ALLEN DATAGRAPH products are normally factory preset for the power requirements of the 
destination country. The machine's configuration is indicated on the power input module as either 
115V or 230V. To change the configuration: 

a. Disconnect the AC power cord from the fuse 
block on the power input end panel. 

b. Open the fuse block cover with a small 
flat screwdriver. 

c. Orient the fuse block so that the desired 
voltage appears in the fuse block cover. 

d. Close the fuse block cover and verify that 
the desired voltage is showing. 

There are two power entry modules on the Engraver.  
The top Power Entry is connected to the Control and 
the bottom is connected to the Laser.  The control uses 
about 300-400 watts and the Laser uses about 700 
watts of AC power. 

Computer Connection 
System Interfacing 

All Allen Datagraph products utilize serial (RS-232) interface or optionally USB (universal serial 
bus) interface.    Use of the USB requires a USB to Serial converter.  The recommended USB to 
serial converters are described in TSB Title: Recommended USB devices Web Site Copy / CD 
Copy on the technical support page of the Allen Datagraph web site. 

The serial interface is factory preset for 9600-baud, no parity, 8 data bits, 1 stop bit.  The 
Engraver, when used with the supplied plotter cable, automatically supports both HARDWIRE 
and XON / XOFF software handshaking.  
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Connect the plotter cable supplied with the Engraver to serial port and to the communications 
port on the host computer. A "null modem" cable may be used on serial XON / XOFF 
communications only and is available at computer supply stores. 

Because of the bi-directional communications required by the Engraver system the use of the 
supplied communications cable and one of the com ports or a USB to Serial on the host computer. 

See your computer documentation for proper set-up of the communications port. 

Loading Allen Engraver Software 
The Firmware Utility CD contains: 

1. The Engraver Interface Utility program for communication with the Engraver. 

2. A current revision of firmware. 

"Firmware" is software that controls the machine functions. The 
firmware on this disk is provided for update purposes only and 
should not be installed on new machines. 

3. Manual and sample jobs. 

In order to use the Engraver, it is necessary to install the Remote Panel Utility Program.   

To install and run the Remote Panel Utility program - Open Windows Explorer by right clicking 
on the Start Button.  Find the CD-ROM drive and find the setup file SetupLaserBuildXX.exe (the 
XX reflects the numeric version number of the software and firmware e.g. 
SetupLaserBuildxx.EXE).  Run the setup program by double clicking on the file.  Follow the 
onscreen prompts. 

Installing Firmware 
The firmware on this disk is provided for update purposes only and should not be installed on 
new machines.  In general you should not install a firmware update unless directed by a 
member of the technical support staff.  Firmware updates are available on the technical support 
page of the Allen Datagraph web site at http://www.allendatagraph.com. 

This procedure details the firmware upgrade procedure.  Normally firmware is only sent to 
customers when a software problem is reported that has been fixed in a later version of the 
software. 

From time to time Allen Datagraph will recommend that you upgrade your firmware in your 
Allen Datagraph Engraver.  A file can be downloaded from the Allen Datagraph web site and 
saved to the desktop.   

Before running the setup program be sure to exit the older version of the Remote Panel. 

XP Instructions 
The downloaded file is a .zip file. You can run the setup program just by double clicking on the 
*.zip file then double click on the setup *.exe file.    

Other Windows Operating Systems 
If you have not already installed Winzip on your computer, download and install the Winzip 
program from http://www.winzip.com.  Then you can open the zip file by double clicking on it.  
Drag and drop the contents of the zip file to your desktop. 
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The setup program will run to install the Remote Panel and the firmware on your Windows 
computer.  If instructed by the factory to upgrade your firmware, follow the firmware upgrade 
instructions below.  If you were only instructed to upgrade to a new remote panel you have 
already completed this task and do not need to install the firmware. 

Firmware Installation Instructions: 
Do not use this section unless instructed to do so by Allen Datagraph. 

Turn on the Allen Datagraph 
equipment to be upgraded and 
connect it to your computer with 
the supplied serial cable.  Start 
the Remote Panel by clicking on 
start, All programs, Allen 
Datagraph, Laser Remote Panel.  
Click on Setup, Com Port and 
verify that the correct Com port 
has a check next to its name.  
Click on Setup, Other Parameters 
and select Menus Advanced, OK. 
Click on Action, Upload 
Firmware.  Select I960a.hex file 
and click Open. If the upload 
fails, you will be given a backup procedure to 
follow on the computer screen. 

Laser Pointer Alignment 
The purpose of this procedure is to aim the laser pointer so that it hits the same spot as the laser.  
Since the laser is invisible it is important that we be able to know where the laser will fire without 
turning on the laser. 

Before powering on machine with laser attached, turn on power 
to control and verify joystick on pendant can move the arm the 
complete length of travel and the mirror mount can be moved 
from the far end to the near end. 

Power off machine and place laser on shelf at about 20° angle to 
the arm.  Tape a piece of paper to the wall so that when the laser 
fires the laser will hit the piece of paper.  See top view at right. 
Connect laser power connector to laser. 

Turn on power to control and laser.  Start the Laser Remote 
Panel.  Enter the password to start the program.  This password will be supplied in a separate 
document.  Select the com port that the laser is connected to by selecting setup -> com port.  
Bring up main menu by selecting setup -> Main menu.  You should see data in the version box 
indicating successful communication with engraver.  If the boxes do not fill in verify the engraver 
is on, the communication cable is connected and you have selected the correct communication 
port. 

A
rm

Electronic
Box

X-axis
Frame

Paper Target taped to wall
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Set the laser power to 2 watts.  Click on OK. 

Set the Align – Run switch to the Align position.  While nothing is between the laser and the 
target press the fire button.  This should create a black circle on the paper target.  Turn on the 
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laser pointer.  If the pointer does not point to the center of the black circle adjust the pointer 
alignment screws on the front head of the laser.  Move the laser a bit and fire again.  Repeat 
adjustment until laser pointer points to center of black dot. 

Laser Alignment 
Screw the laser alignment tool into the front edge of the 
mirror assembly.  Attach laser to arm with bolts.  Do not 
tighten.  Set all 4 laser alignment screws to their mid position   
Turn on laser pointer.  Using the T-Square align front edge of 
mirror assembly perpendicular to the mirror mount.  Adjust 
height to that red dot is with in 0.25 inch of the center cross 

hairs.  Tighten mirror mount. .  Joystick mirror assembly 
close to the laser.  Use the laser alignment screws closest to 
the mirror assembly to get the laser pointer to point at the cross hairs. 

Joystick mirror assembly to far end of arm.  Using the laser alignment screws 
farthest from the mirror assembly next to the laser fan exhaust, point the laser 
pointer at the cross hair.   

Repeat alignment near and far from laser until no adjustments are necessary. 

Tighten nuts so that alignment screws do not turn.  Snug up laser bolts.  Do not tighten.  Verify 
alignment did not change and laser pointer still points to center of target at the near and far end of 
the mirror travel. 

Mirror Alignment 
There are two, mirror alignment Allen 
screws with small access holes in the 
mirror assembly.  One screw 
adjusts one axis of alignment and 
the other adjusts the other axis of 
alignment.  Remove the laser 
alignment tool from the side 
closest to the laser and attach to side closest to media. 
The object is to create the burn pattern above when firing the laser through the 
laser alignment tool. Set the Align Run switch to the align position.  Set up a target under the 
laser mirror by building up structure of crossed 4x4 near the mirror assembly.  Use a piece of 
paper for the target.  The laser power should still be set to 2 watts in the main menu from laser 
pointer alignment section.  Press the fire button to fire the laser.  Check the pattern.  Adjust one of 
the mirror alignment screws.  Move paper and 
fire again.  Repeat Fire, Adjust, move target 
until 4 distinct areas of burn are seen.   

Remove laser alignment tool and attach lens.  
Attach air hose to lens assembly. 

Control Panel 
The front control panel is the interface for the 
Engraver.  It is used for Head positioning and 
aligning the engraver.   
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Fire 
The fire button fires the laser and the wattage set by the main menu when the align/run switch is 
set to the align position.  It has no effect when the switch is in the Run position. 

Align/Run 
This switch controls whether the computer turns on the laser or the fire button turns on the laser.  
If the Run position the computer controls the firing of the laser.  In the Align position the fire 
button turn on the laser as long as the fire button is depressed. 

Pause Stop/Run 
The pause switch is interrogated at the beginning of each vector.  If the pause position no vectors 
are processed.  It the run position vectors are processed.  

Led Pointer On/Off 
The red led point can be turned off and on with this switch. 

Joystick 
The analog joystick labeled (left, right, in, out) allows the head to be moved in the direction of the 
deflection of the joystick while facing the mirror assembly.  Small deflections move the mirror 
assembly slowly; large deflections move the mirror assembly faster. 

Remote Panel 
The Remote Panel program is used to address all engraver functions.  It should be loaded onto the 
computer that is directly connected to the engraver.  It can be run in the background with most 
cad programs.  

Remote Panel Functions 
To start the remote panel double click on the icon 
on the desktop or click on Start -> All Programs-
> Allen Datagraph -> Laser Remote Panel.  The 
remote panel is password protected to keep 
untrained personnel from running the 
laser.  The Default password is 
transmitted in a separate document. 

Action menu 
Open Graphic Image 

This allows opening an image and 
displays a preview of the image on the 
screen. 

Open Graphic Image (no 
preview)   

This removes the preview option from 
the open file box and runs faster but 
without the preview in open dialog box. 
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Outline Image 
This function moves the mirror around the edge of the image.  It is used to verify placement of the 

image before it is burned. 
Send Image 125/150/200/300 DPI 

These menu items send the currently opened image to the laser engraver. 

Invert Black and White 
Normally the image burned is mostly black and only the white pixels are burned.  If the image is 
not mostly black you can invert the black and white. 

Queue Opened as job 125/150/200/300 DPI 
You can queue up multiple jobs to be burned.  The program display this 
size of the image as well as the number of pixels in the x and y axes.  
Click yes adds the opened image to the job queue where the mirror 
assembly is currently positioned. 

Display Job Queue 
The display job queue on the action menu displays a list of jobs in the queue.  Clicking on the job 
name in the list at the top displays the 
parameters for that job. 

Restart Jobs 
If the power fails during a job you can 
restart the job if you have found origin 
before you queue any jobs.  After the 
power is restored you can find origin again 
and click on restart jobs.  The image will 
start where it left off burning. 

Run Jobs 
Clicking on Run Jobs, runs all the queued 
jobs. 

Move Center 
After selecting a job in the list you can click on move center to move the mirror assembly to the 
center of the selected job. 

Outline Jobs 
Outline jobs, moves the mirror assembly around each queue job. 

Clear All Jobs 
Removes all queued jobs from the queue. 

Delete 
To delete a job select the job to delete in the top list and click on delete to delete that job. 

Image Size 
Displays the size of the selected image in pixels and the selected units. 
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Position 
The location of the job from power up or last find origin.  This value can be changed by clicking 
on the job that you want to change.  Changing the value.  Then click on another job or this job. 

Dots Per Inch 
Resolution of the burned image. Acceptable values are 125, 150, 200, or 300.  This value can be 
changed by clicking on the job that you want to change.  Changing the value.  Then click on 
another job or this job. 

Laser Power 
Number of watts of laser power for this job.  This value can be changed by clicking on the job 
that you want to change.  Changing the value.  Then click on another job or this job. 

Start Location 
Most jobs will use center positioning.  Lower left position can be used if the center of the job 
cannot be found.  This value can be changed by clicking on the job that you want to change.  
Changing the value.  Then click on another job or this job. 

Inverted 
The image will be inverted from the file if yes is select.  No change if no is selected. This value 
can be changed by clicking on the job that you want to change.  Changing the value.  Then click 
on another job or this job. 

Job ID 
This is an optional field if you turn on job id’s on the option menu. 

Cancel, Continue, Pause Job 
These commands will cancel, continue, or pause a job being sent.   You can also use the pause 
switch on the pendant to pause the job.  Note: pausing a job can cause a discontinuity in the 
image. 

Find Origin 
When you power up the engraver it does not know where the x-axis is positioned.  You use this 
command once after you power up the engraver to find the x-axis zero point.  Early versions 
(model 201) of the engraver do not support the Find Origin command.  Use this with the restart 
jobs button on the job queue to restart a job after a power failure. 

Advanced menu items (These menu items appear if you select the advanced 
menu on the Setup Other Parameters menu) 

Open Com Port 
Will initialize the communications port.   

View HPGL file 
The laser operates in two modes.  One is the raster mode, the 
other is the vector mode.  The view HPGL file allows 
viewing a vector file.   
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Send HPGL file 
Send HPGL File will send a HPGL plotter file directly to the engraver.  Typical origins HPGL 
files include the Allen Driver, CorelDraw or some other design software.  To send a HPGL file 
from the remote panel program click the Send HPGL File menu item to open the select file 
window.  Select the files desired and click the Open button.  This will send the file directly to the 
engraver in vector mode.  Instead of burning a raster image this will burn the edges or outlines of 
the image.  Only slower speeds (< 2 cm/sec) are supported by this command due to the 
cantilevered design.  

Close Com Port 
Closes the communications port so that other programs can use the port.  The remote panel 
program will automatically close the port in most instances when it is not actively communicating 
with the engraver. 

Half Speed 
This option delivers twice as much power to each pixel of an engraved image and runs at half 
speed. 

Quarter Speed 
This option delivers four times as much power to each pixel of an engraved image and runs at ¼ 
speed. 

Eighth Speed 
This option deliver eight times as much power to each pixel of an engraved image and runs at 1/8 
speed. 

Convert Gray Scale Image to B and W 
This command will use the select gray scale level to set each pixel to either black or white.  The 
resultant preview will be displayed. 

Upload Firmware 
Should your firmware ever need to be updated, this command will locate the firmware file and 
send it to the engraver. 

Setup Menu 
Main Menu 

Firmware Version 
Displays the model number, software part number 
and software version of the firmware loaded into 
the engraver.  It should match the version 
displayed when you start the Laser Remote Panel. 

Media Height 
This is the length of the rail. 
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Position 
Displays the current position of the mirror assembly. 

Last Saved Error Message 
If an error is detected that causes the system to shut down you can power off the engraver and 
power it back on and the error that occurred will be displayed here.  This error message can be 
very old as it is saved until the next error message occurs. 

Clear Error 
Pressing the Clear Error button will clear the currently saved error message.  This allows knowing 
that a displayed error occurred since the Clear Error button is pressed. 

State 
Pausing a job with the Action -> Pause will change the state to Pause state.  You can resume the 
job with either Action -> Continue or bringing up the main menu, selecting ready and clicking on 
OK. 

Laser Power 
Allows controlling the amount of power delivered to each pixel.  Use power based on the image 
type and material being burned. 

Image Type Laser Power 
Photo 7-9 
Lettering 9-11 

Move Speed 
This is the speed at which the arm moves while moving between jobs or doing y only moves 
while burning a job.  Suggested value is < 3 cm/sec 

Acceleration 
This parameter controls how fast the vector reach final velocity.  Suggested value 1 

Save Setup 
Clicking on Save Setup will save changes in parameters so that when you power on the machine 
the parameter will be remembered. 

Cancel 
Changes made to values are ignored and the menu is closed. 

OK 
Changes made to values are saved in the engraver until the engraver is powered off. 

Advanced Settings 

Draw Speed 
Used when sending hpgl files containing outlines of shapes this is the max speed the mirror 
assembly moves in relation to the media.  Max value is 3 cm/second due to cantilevered design. 

Speed Resolution 
Setting the speed resolution to mm/second allows finer resolution of the speed 
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Cad Override 

The CAd Override radio buttons enables or disables the CAD override function.   With the 
function On, the cutter will ignore some of the HPGL control commands sent from the cutting 
software.  With the function Off, the software can control these HPGL functions.  Some CAD 
systems will work correctly only when this feature is set to on.  This features has no effect on 
engraved images. 

These commands include: 

AS  set acceleration 
FS set force 
KA set minimum angle 
KN set knife offset 
IP  input P1/P2 
RO rotate 
SC  set scale 
SP select pen 
ST select tool 
UV  up velocity (move speed) 
VS down velocity (cut speed) 

Dynamic Power 

The Dynamic Force radio buttons engages the dynamic force function, which instantaneously 
adjusts the force on the fly based on the actual velocity of the mirror assembly with relation to the 
media. The engraver must accelerate and decelerate as they cut around corners.  Some medias 
require different power settings for different speeds.  This parameter allows for building a 
database for these materials and when enabled will greatly improve the cutting on these materials. 
(See the Dynamic Force Section for more details). 

Other Parameters Menu 
Gray Scale Level 

If a gray scale image is opened 
this value determines whether 
the pixel is black or white.  
Pixel values > 128 are white. 

Velocity Pad 
While accelerating to perform a 
vector scan the velocity takes 
several milliseconds to stabilize 
the velocity to obtain a good 
image.  A value of 8 waits 32 
milliseconds after the 
acceleration phase before 
starting the raster scan. 

Left-Right Move Alignment 
Raster scans going left and right need a fudge factor so they appear in the same place.  Double 
clicking the value with perform a small 2 inch by 2 raster line job with the laser off and will 
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automatically calculated the correct left-right move alignment.  This value changes for each dpi 
and for half, quarter, and eighth speed. 

Model 
Model 201 machines are among this first machines shipped.  They have smaller motors and a 
linear amplifier.  These machines do not support find origin. 

Model 202 were shipped with larger motors and a PWM amplifier with a gear ration.   

Model 203 are currently being shipped and have a PWM amplifier with a different gear ration. 

Model 204 are hybrid machines with model 202 x motors and 203 y motors. 

Index Move Parameter Velocity/Acceleration 
To draw very good pictures the acceleration and velocity between rows in the x-axis must be less 
than 1.  Start with 0.2 for both values and reduce values to slow x moves between rows and 
increase to time between rows. 

Start Location 
Choose center if you position your job using the center of the media.  Choose lower left if you 
cannot use the center of the media to set up the job. 

Job ID 
Job ID on will ask for a job id for each image opened. 

Menus 
Some items on the menu are normally not used and can complicate the learn process of the 
machine.  Setting menus to normal will hide menu items that are normally not used. 

Units 
Setting units to metric will display sizes in cm.  Setting units to English will display sizes in 
inches. 

Advance Parameters 

Index Location 
The index locations are the values returned from the encoder after a Find Origin command.  They 
are normally between 200 and 1800 encoder counts. 

Laser Setup 
Laser setup are parameter used to convert the 
laser watts on the main menu to the amount of 
power output to the laser.  There should be no 
reason to change these values from their default 
values of 30, 50, and 550. 

End Point 
This is the location of mirror assembly goes to 
after a job.  It is normally not necessary to change 
this from Center. 

Com Port 
The Com Port menu is used to set the 
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communications port to the Remote Panel only.  It does not set the communications port for the 
design software or Allen Windows Driver. The Local Echo mode is used in communicating 
directly from the remote panel while in Terminal Mode.  

Font Size  
Sets the font size for the Remote Panel Program.  

Dynamic Power Adjust  
This feature is considered an 
advanced feature and does not 
appear on the Setup menu 
unless the menu is set to 
advanced on the other 
parameter page.  Dynamic 
Power Adjust sets up the 
dynamic power parameters 
and database.  To establish a 
new material database type in 
the name of the new material 
in the Material Selection 
box and click Add.  In the 
Force and Velocity Window, 
type in the desired power vs. 
velocity that you have established for 
the material.   The recommended 
method for establishing the various power vs. velocity numbers is to run the test cut at various 
velocities and record the results for entry here. 

Enter the Maximum cut speed for the media in the Max Draw Speed window.  This should be 3 
or less for the engraver. 

Before using Dynamic Power Adjust, it is necessary to send the power setup to the engraver 
memory by clicking the Send Power 
Setup to Engraver button.  This needs 
to be done after each time the cutter is 
loaded or reset. 

Diagnostics 
See the diagnostics section of this 
manual.  Additional diagnostics are 
available if advanced menus are used. 
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Window 
This menu allows selection between 
the three different communication 
windows to the engraver. 

Terminal 
The terminal window allows typing 
commands directly to the engraver 
and seeing the response.  You can 
also monitor the communications 
between the engraver and the remote 
panel if you have enabled the debug 
log. 

Image Fit To Window 
This window is used to display a 
preview of the image that is currently 
opened. 

HPGL Image 
This window is used to display a 
preview of an Hpgl image using the action view Hpgl file command. 

Help 
About 

Displays the version of the remote panel loaded on the computer. 

Clear Log 
Clears the terminal window. 

Advanced items 
Enable Debug Log 

Turn on communication monitoring for the remote panel.  Communications between the remote 
panel and the engraver are displayed in the terminal window. 

Enable Character Log 
Turn on detailed communication monitoring for the remote panel. 

Joy Stick 
JOYSTICK The joystick is used for positioning the 
mirror assembly. 

The four ARROW KEYS are used to jog the arm or 
mirror assembly.   With the Jog/Slew box unchecked so 
that Jog/Slew = Slew, the joystick speed will be the 
speed set in the Joystick Speed Window.  Left Click and 
hold the arrow button to move the mirror.  With the 
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Jog/Slew box checked so that Jog/Slew = Jog, the arrow buttons will jog the mirror that fixed 
distance each time the button is clicked.   

Image Preparation 
Image Selection 

Images with a lot of contrast burn better 
than images that are mostly white or 
mostly black.  Particularly difficult are 
baldheads and white wedding dresses as 
large areas are completely white.  Adjust 
the contrast/brightness so that you have a 
darker image that would be desirable for 
a photograph.  

Layout Stone 
Using a program such as Gerber Omega, 
Corel Draw or Adobe Illustrator layout 
the text and the outline of the image you 
are creating.  In this example I will layout 
a 12x12 grass marker using Gerber 
Omega with a photo engraved in the 
center.  I will use 150 dpi for this 
example.  I have used construction lines 
to mark the edges, margins, and location 
of the 6 x 6 photo of fluffy.  If you do not need cut lines for rubber cutting and sand blasting you 
can layout the monument directly in Photoshop. 

Export as tiff 
Use File -> Export, Select export all,  Select Save as type = TIF – Tagged Image file format.  
Select location to save file and click on save.  Change color to black and white,  Change 
resolution to 150 dpi and select compressed image.  Click on OK. 

Open Tiff file with Photoshop 
Create a new document with photo shop.  Select 
a 12x12 image with 150 dpi in bitmap mode.  
Open tiff file created with Gerber Omega and 
copy and paste it to the new image.  View rulers 
and add same construction lines as in Gerber 
Omega.   To calculate the minimum required 
resolution of a scanned photo you take the size 
of the desired area in the layout for the photo 
horizontally in inches and multiply by the burn 
resolution.  150 dpi * 8 inches.  This is 1200 
pixels horizontally.  Now measure across the 
width of the area of the photo that you wish to 
scan.  Suppose this width is 3 inches.  Divide 
the number of pixels required for your image by 
the size to get the minimum horizontal scan resolution.  1200 / 3 = 400 dpi.  Repeat for vertical 
measurements.  Scan image at the larger resolution.  If you have a digital photo you must have at 
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least the number of pixels across the image as are required for your monument area at the dpi you 
are using (1200 pixels in this example). If your digital image is much smaller that this you will 
not get good results.  You can normally shrink images without problem but increasing sizes of 
images is usually not successful. 

 Scan Image at Calculated DPI 
In the previous section we calculated we needed a 400 dpi image for our 3 inch photo or 1200 
pixels across for a digital photo.  Scan the photo at 400 dpi using your color scanner.  

Open the scanned image in Photoshop.  Set background color to 
black and increase canvas size to 9 in by 9 in to add a black 
border 

Cutout Image 
If you are using a oval/elliptical image on the final layout you 
can simply choose the elliptical marquee tool and select the area 
of the photo you want to burn.  Edit  -> copy, create new image 
9 in x 9 in at 150 dpi RGB and paste selection into new image.   

For more complex cutouts you have to create a multiply mask.  
Select black for background color.  You start with a new image 
9 in x 9 in at 150 dpi. Choose background color for contents.  In 
my case I will use the rounded rectangle tool to create the 
multiply mask.  I chose a radius for the rounded rectangle as 200 
px.  I drew the rounded rectangle 8 inches square centered. 

 

Select Layer flatten image.  I then saved the multiply 
mask for future use. 

On the image create a new layer with layer -> new -> 
layer.  Copy the multiply mask into the new layer.  
Select multiply for the layer-blending mode.  This 
adds a rounded rectangle as the image cutout shape . 
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Feather edge 20-50 pixel 
Select the magic wand tool and set the tolerance to 1.  Draw a small square anywhere in the black 
border.  This selects the black border as the image.  Next right click and invert the selection, 
which will select the rounded rectangle image.  Select -> modify -> border and select 20 pixels 
for the range of the blur.  Select Filter -> blur -> Gaussian Blur.  Select 20 pixels and click on 
OK.  This will fade the edge of the image to black. 

Discard color 
Image mode gray scale. 

Add a white border for complete range of 
white to black 

In order for PhotoGraV to see a complete range of white to 
black we need to have a white border.   

Select white background color 

Increase Image -> Canvas Size to 10” x 10”  

Save Image as Uncompressed BMP 
File -> Save as.  Change file type to BMP. 

Open Image in  PhotoGraV  
(www.photograv.com) 

PhotoGraV is a program that converts a gray scale image to a 
black and white image.  There are more white pixels in the 
area where the image is lighter and more 
black pixels where the image is darker. 

The first time you start PhotoGraV select 
user defined and click on load.  Set max 
laser power to 30 and max speed to 13 
in/sec.  Add lens size of 0.003 and 3 dpi 
selections of 150, 200, and 300 dpi.  To 
process an image open the image by 
clicking on open image and load the BMP 
file saved from photo shop.   

 

Select material anodized 
aluminum 

Select material Anodized Aluminum 
(Black) and click on OK. 

Auto process 
Click on Auto Process    

Save engraved images as bmp 
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Click on file Save Engraved Image 

Back in Photoshop Open the PhotoGraV Image 
File Open  

Invert image 
Image -> Adjustments -> Invert 

Put two images together 
Select the area of the image using the rectangle tool and 
paste it into the monument layout. 

Flatten Image and Save it. 
If you have multiple layers use the Layer -> Flatten image 
and then save the image to be burned. 

 

 

 

 

 

 

Media Leveling Setup Loading Instructions 
The purpose of this 
section is to set the 
distance between the 
end of the lens and 
the media to be 
engraved to be level 
with respect to the 
arm at the focal 
distance of the lens. 

Metal
Plate

To perform this operation we will use the, Focus Spacing 
Tool, Leveling/Focusing scissor jacks, and the 4x4 and 2x4 
blocks to build a stable tower to place the media to be 
engraved.  Place the metal plate directly on the conveyor.  
Build up a stack of 4x4 and 2x4 top plate and media to be 
engraved so that it is 0.5 to 2 inches 
below the lens. 

Next with the laser pointer on align the 
edged of the media with axis of the 
engraver so that the laser tip when moved 
with the joystick follows the edge of the 
media. 

Place the three leveling jacks under the 
metal plate as shown.  Using the ratchet 
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wrench adjust the height of the plate so that the Focusing Spacing tool will just fit between the 
media to be engraved and the lens tip.  

Using the joystick position lens over each jack and adjust height/focus with the jack below it.  
Changes in the height of one jack may slightly change the height at another jack so you must 
repeat each height adjustment for each jack. 

If you are running more than one job at a time you will need a set of jacks, two plates and 
additional lumber pieces for each addition engraved piece. 

Burning a Raster Image 
Most images must be centered on the media that is to be engraved.  To position the engraver 
above the image use a ruler to find the center for each axis and move the mirror assembly with 
the joystick so the brass tip is at the center of the media. 

Use Action -> Open Graphic Image in the Laser Remote Panel to open the 
image to be engraved.  Then use Action -> Queue Opened Image as Job 
150 DPI. (The DPI chosen must match the DPI setting for the design.)  
This will read the current position as the center of the engraving.   The 
program will then display the size of the image to be burned in pixels and 
inches/cm.  Answering yes will add the job to the queue. 

Using the Job Queue 
To open the job queue Use Action -> Display 
Job Queue.  Click on the job queued above 
and set the wattage for the laser for the job.  
You can  split the job into two pieces if you 
want to use a different wattage for text and 
graphics.  You can queue up the two layers 
and set the wattage for each layer separately.  

Remember to save the changes made in any 
parameters by clicking on a job in the queue. 

After all jobs are setup you can start running 
the jobs by turning on the air supply and 
clicking on Run Jobs button. 

 

Maintenance 
Cleaning 

The regularity with which the plotter needs to be cleaned is dependent on the usage, as well as the 
climate and contaminants in the plotter’s environment. It is recommended that the following 
cleaning steps be done at least as often as indicated for each procedure: 

1. Weekly, the lens should be removed or if you forget to turn on the air and burn an 
image without the air running. 

2. Monthly, the 3 motor belts should be inspected for wear.  New belts should be 
obtained and installed when belt teeth are missing or worn. 

3. Bi-Monthly open electronic box and blow out dust. 
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Mechanical Adjustments 
Belt Tension 

The engraver servomotors use timing belts to control the arm (X axis) and mirror assembly (Y 
axis) positions. The belt tension and wear should be inspected if engraving quality deteriorates. 
To inspect the belts, remove the metal cover over the y motor.  To remove the covers remove 2 
large screws on the cover. 

Y-Axis 
The Y-axis short belt runs between the Y-axis servomotor and a gear assembly. To adjust the 
tension of this belt, it is necessary to reposition the motor bracket.  

1. Depress belt half way between pinion gear on motor and drive gear with about 10 
oz (300 grams) of sideways force.  The belt should move 3/16 of an inch or 0.5 
cm.  To adjust tension loosen the Phillips head motor bracket screws and apply 
hand pressure to tighten the belt. 

2. When the belt is tight and the motor shaft is parallel to the bearing shaft, tighten 
the three Phillips head motor bracket screws. Premature belt failure will occur if 
these two shafts are not parallel. 

3. Verify tension. 

The long belt is adjusted using a lead screw located behind the control panel. To set the long 
belt's tension: 

1. Position the carriage 12 inches from the end.  Pluck the belt like a guitar string.  
The pitch should sound about the same as the bass string of a guitar. 

2. Remove the rail cover housing  

3. Loosen the lead screw lock num 

4. Adjust the lead screw so to tighten or loosen the belt 

5. Set the lead screw lock nut. 

6. Verify belt path and tension. 

7. Replace the rail cover housing 

X-Axis  
The belt along the frame allows the x motor to move along the 
frame.  To test the tension move the arm to 12 inches from the end 
of the x-axis travel.  Pluck the belt like a guitar string.  The pitch 
should sound about the same as the bass string of a guitar. 

1. To adjust the tension loosen the lead screw lock nut.  
To tighten turn screw clockwise. 

2. Tighten the lead screen lock nut. 

Diagnostics 
The engraver firmware contains a set of resident diagnostics. 
When the engraver is powered up, it automatically performs a 
self-test program to check all operating parameters. If a malfunction is detected, the mirror 
assembly will not initialize to the far end.  If the remote panel is open and the com port is opened 
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and reason for the failure will 
be output on the screen.  
Typing the letter E enter will 
also display the error message 
an start the ASCII remote 
panel  

The fail-safe system is 
designed to detect failures in 
the operation of the 
electromechanical system in 
the engraver and to prevent 
such failures from causing 
other damage. The engrave 
contains circuits that 
continuously monitor power 
supply voltages and the 
microprocessor system clock. 
The engraver will go to a 
hardware-reset condition if these voltages are not within normal limits. Over current conditions 
on X and Y-axis drive motors are also monitored. An over current condition will cause a relay to 
open, cutting off power amplifiers from the drive motors. In addition, a number of internal 
sensors are continually checked. If any potentially damaging errors are detected, the system will 
cause the fail-safe circuits to open the relay and place the engrave in the error state. The error 
message will appear in the serial.log file in directory C:\Program Files\Allen Datagraph\Laser 
Remote Panel.  They will also be displayed in the Setup -> Main Menu if the engraver is reset 
and the main menu is displayed. 

Diagnostic Operation 
The diagnostics in the engraver exist at several levels:  

1. POWER-ON 

2. CONTINUOUS HARDWARE AND SOFTWARE MONITORING 

3. OFF-LINE 

The POWER-ON diagnostics are performed at power-on or reset of the microprocessor and test 
the microprocessor, memory, servo analog and digital hardware, and some of the testable sensors.  

After initialization, CONTINUOUS HARDWARE AND SOFTWARE MONITORING check 
the sensors and fail-safe monitors for machine malfunctions. If a malfunction is detected, an error 
message is output to the serial port, the protection relay is opened and the engraver ceases 
operation.  

OFF-LINE testing is used for manufacturing and field service testing and for making certain 
adjustments to the engraver such as motor balance.  

To Run Diagnostics if the engraver unit is stopped due to an error, Display the terminal window, 
clear the log file, and press E enter to display the error message and enter the ASCII front panel  
mode. 

All diagnostics are run from the remote panel, most of which require the advance menu option on 
the other parameter page.  To run the customer diagnostics from the remote panel program:   

Open the remote panel 
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Click on the Diagnostics Menu 

 

Customer Diagnostics  
Calibrate 07 

Normally the engraver does not need any calibration as none of the mechanical components have 
a tolerance.  Use the default calibration to set the calibration constants.  Calibration is used to set 
the size of a pixel so that a 150 x 150 pixel square engraved at 150 dpi engraves a 1-inch square. 

Default Calibration 08 
Sets the calibration constants back to the factory defaults prior to initial calibration.  A 

Pause Switch 28 
Running this diagnostic will display 000 or 111 depending on the state of the pause switch on the 
pendant. 

PWM Amplifier Status 
This displays the power amplifier status if the PWM power amplifier is installed. 

X Joystick 35 
Display the value from the ADC from the x-axis joystick on the display.  Deflecting the joystick 
in the x-axis to their extremes will vary the displayed value from about 008 to 0FC.  The center 
home position should display a value from 78-98. 

Y Joystick 36 
Display the value from the ADC from the y-axis joystick on the display.  Deflecting the joystick 
in the y-axis to their extremes will vary the displayed value from about 008 to 0FC.  The center 
home position should display a value from 78-98. 

Manufacturing Diagnostics 
It is not recommended that the Manufacturing Diagnostics be run unless instructed by 
direct contact with Allen Datagraph Technical support.  Damage to the system is possible. 

Trouble Shooting 
Problem Solutions 

 •  

Error Codes 
If the internal microprocessor detects an error condition, the letter E0 and a 2 digit code will be 
displayed on the control panel. Any key pressed after the error is displayed will place the machine 
in the diagnostic mode, indicated by a flashing "D" on the control panel. Recommended 
diagnostic procedures  (D##) are listed in the error description. 

• NONE One or more of the 7 LEDs on motherboard are off - check PCBs loose in socket, 
fuses in power entry module blown, 115/230 VAC switch in wrong position, front panel PCB 
disconnected, loose cable from power supply to motherboard PCB, Missing + 5 volts, + 15 
volts, + 32 volts, micro PCB dead.  
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• bad calibration constants. Must run diagnostic D008, then calibrate engraver. 
• collision sensor tripped 
• escape command parameter out of limits 
• eerom initialized to default settings 
• escape command not implemented 
• EPO latch failure check seating of servo and CPU Board 
• EPO latch or EPO reset failure  check seating of servo and CPU Board 
• excessive position error x axis or excessive position error y axis.  This can be caused by 

speed or acceleration too high, obstruction in way of machine, bad calibration constants, 
power surge, servo motor / encoder failure, servo PCB failure, power amplifier pcb failure, 
relay on motherboard. 

• buffer overflow 
• hpgl compatible command parser error 
• initial move positioning error; carriage didn’t move  
• invalid character in escape command 
• joystick disabled 
• motor over-current, DAC or analog failed  check seating of servo and CPU Board 
• motor over-current - power amp failed  check seating of servo and CPU Board 
• pause switch on 
• Relay opened. No reason given 
• rs232 device overrun (broken cable, wrong handshake, broken serial hardware in 

computer/engraver) 
• rs232 framing error Engraver communications default for serial port is 9600,n,8,1. Data 

received from serial port does not appear with these parameters 
• rs232 parity error 
• servo interface bus error 
• servo motor over current Normally caused by motor jam. Check servo pot adjustment. 
• servo motor over-current sensor failure  check seating of servo and CPU Board 
• servo motor over current sensor failure 
• servo timeout Cutter software error or servo PCB failure - D10. Check earth ground. Prevent 

electrostatic discharge. 
• timeout latch failure  check seating of servo and CPU Board 
• too many parameters in escape command 
• unexpected arithmetic fault 
• unexpected constraint fault 
• unexpected nmi interrupt 
• unexpected machine fault 
• unexpected operation fault 
• unexpected parallel interrupt 
• unexpected protection fault 
• unexpected real arithmetic fault 
• unexpected reserved fault 
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• unexpected servo interrupt 
• unexpected trace fault 
• unexpected type fault 
• unexpected interrupt 
• waiting for first vector to complete 
• x axis encoder detector failed 
• X-axis encoder failed  check seating of servo and CPU Board 
• X-axis position counter failed  check seating of servo and CPU Board 
• X-axis encoder detector failed  check seating of servo and CPU Board 
• Y-axis encoder failed  check seating of servo and CPU Board 
• Y-axis position counter failed  check seating of servo and CPU Board 
• Y-axis encoder detector failed  check seating of servo and CPU Board 

Appendix A Floor Space Layout 
Web Site Copy / CD Copy
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